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VERIFICATION DE L’EXTENSION BQR TOOLKIT DERATING AND MTBF 
 

✓ Ouvrez votre logiciel Altium Designer 
✓ Tout en haut à droite à côté de votre profil se trouve un menu déroulant, cliquez sur ce dernier et 

appuyez sur le déroulé « Extensions and Updates… » comme indiqué dans la Figure 1. 

 
Figure 1. Etape 1 pour aller dans "Extensions and Updates" 

✓  Une nouvelle fenêtre associée s’est alors ouverte. Dans cette fenêtre, vous trouverez 3 onglets :  
Installed, Purchased, Updates. 

 
Figure 2. Fenêtre "Extensions and Updates" 

✓ Vérifiez la présence de l’extension « BQR Toolkit Derating and MTBF » dans l’onglet Installed, au 
niveau du menu déroulant Software Extensions. 

 
Figure 3. Extension "BQR Toolkit Derating and MTBF" 

✓ Si l’extension n’est pas présente, recherchez-la dans le deuxième onglet « Purchased » et cliquez sur 
la petite flèche de téléchargement. 
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Figure 4. Onglet Purchased > Software Extensions > BQR Toolkit Derating and MTBF 

 

 

Remarque :  
Dans la recherche de l’extension, vous pouvez utiliser la barre de recherche, située à droite du menu 
déroulant « Software Extensions ». 

 

✓ Un message d’information s’affiche alors à votre écran, vous demandant de redémarrer Altium 
Designer afin de finir le processus d’installation. Suivez l’indication. 

 
Figure 5. Message d’information 

 

 

 

 

 

 

 

 

 

 



- 6 - 

EDA Expert          
TUTORIEL FiXtress   

 

INTRODUCTION SUR L’INTERFACE SYNTHELYZER 
 

Ouverture de l’extension 
✓ Ouvrez le projet dont vous voulez évaluer la fiabilité.  
✓ Ouvrez un schéma du projet. 
✓ Cliquez sur File » New » Synthelyzer. 

 
Figure 6. Démarche pour ouvrir une fenêtre Synthelyzer 

✓ Une nouvelle fenêtre Synthelyzer s’ouvre alors au milieu du logiciel. 

 
Figure 7. Fenêtre Synthelyzer 
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Présentation générale de l’interface 
Vous trouverez dans la Figure 8 suivante une présentation générale de l’interface visuelle vue par l’utilisateur. 
Dans cette interface se trouve :  

- Un en-tête contenant les boutons « Help » et « View License », ainsi que l’adresse où se trouve 
le projet. 

- Les onglets associés aux différentes fonctionnalités 
- La page de travail associée à l’onglet 

 
Figure 8. Présentation générale de l’interface visuel vue par l’utilisateur pour l’onglet « Home » 
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AVANT DE COMMENCER 
 

Tout en haut de l’interface, au niveau de l’en-tête se trouve 2 boutons principaux : le bouton Help et View License. 

Help 
D’une part, le bouton Help permet d’avoir des informations sur l’extension et sur le contact de BQR, à travers le 
panneau Help » About. 

 
Figure 9. Bouton Help 

 
Figure 10. Panneau afficher lors de la sélection Help>>About 

La sélection Help>>Help Topics permet d’ouvrir un manuel d’information abordant différents sujets, comme 
indiqué dans la Figure 11. 

 
Figure 11. Interface du manuel d’information 
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View License 
Le bouton View License permet de : 

- Spécifier l’emplacement du fichier de licence à utiliser ; 
- Visualiser les fonctionnalités activées par la licence ; 
- Acheter une licence, demander l’ajout de fonctionnalités ou activer une licence existante. 

 
Figure 12. Panneau associé à View License 
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LES FONCTIONALITES PRINCIPAUX 
 

En fonction de la licence que vous avez, différents onglets seront proposés en dessous de l’en-tête. Chaque 
onglet sera associé à une fonctionnalité spécifique.  
 
Dans le cadre de calcul de MTBF (Mean Time Between Failure), nous allons ainsi nous focaliser sur 4 onglets 
principaux : 

- Setup 
- Derating & FMECA 
- Parts Count Prediction MTBF 
- Telcordia 332.3 MTBF Prediction 

 
Figure 13. Onglets Setup, FiXtress Properties, Parts Count Prediction MTBF, Telcordia 332.3 MTBF Prediction 

Gestion de donnée 
L’onglet setup permet de configurer les données de la BOM (Bills Of Matérial) que l’outil va utiliser pour réaliser 
ses calculs.  

 
Figure 14. Interface de l’onglet setup 
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Pour cela, il faudrait vérifier et ajuster les menus déroulants afin de les faire correspondre au type de données 
requis par l’outil (Figure 15). Le tableau de données s’actualise alors. 

 
Figure 15. Vérification et ajustement des menus déroulants 

Pour cette configuration : 
- Part Number correspond au numéro de pièce 
- Catalog Number correspond au référence catalogue  
- Manufacturer correspond au fabricant 
- Description correspond à la description du composant 
- Ignore List correspond à la liste d’exclusion 

 
Lorsque l’on sélectionne une ligne de la table de donnée, des informations se remplissent alors dans le tableau 
de droite intitulé « List of Pins ». 
 
Différentes fonctionnalités sont aussi présentées tout en bas de l’onglet.  

 
Figure 16. Bas de page de l’onglet setup 

Parmi ces fonctionnalités, vous trouverez :  
- Une section notée « Calculate fiXtress MTBF » qui permet de calculer le MTBF du projet, en 

fonction des méthodes choisis (Telcordia, FIDES, …) et des configurations choisis 
(environnement et température). 

- Une section intitulée « Include in BOM » sur la gestion des données associés aux stresses et/ou 
au FMECA 

- Un bouton qui permet d’ouvrir directement le logiciel fiXtress depuis l’extension, uniquement si 
vous avez déjà le logiciel fiXtress.  

- Un bouton « Refresh » qui permet d’actualiser l’outil.  
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Derating et analyse de stress électrique 
Le « Derating » (ou Déclassement) est une pratique qui consiste à appliquer au composant une charge (tension, 
courant, etc.) à un certain pourcentage en dessous de sa charge nominale (tension nominale, courant nominale, 
etc.). De ce fait, nous allons ainsi manipuler 3 paramètres :  les pourcentages, les valeurs des charges nominales 
et les valeurs des charges réelles appliquées. 

 
Figure 17. Présentation de l’onglet Derating & FMECA 

1. Le pourcentage de derating :  
Il est déjà établi par défaut, cependant, si vous voulez importer des données relatives à ce sujet, vous pouvez 
directement importer votre document dans la section associée, après la sélection Derating & FMECA » SDTA Lib 
Settings. 

 
Figure 18. Bouton SDTA Lib Settings pour importer les données relatives au pourcentage de derating 
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2. Les charges nominales : 
Les valeurs des charges nominales sont à définir dans la fenêtre Library Editor associée après avoir sélectionné 
Derating & FMECA » SDTA Lib Editor. 

 
Figure 19. Bouton SDTA Lib Editor pour définir les valeurs des charges nominales des composants 

Afin de compléter les données de charges nominales pour tout le projet, sélectionnez All Project dans la section 
Library Components.  

 
Figure 20. Fenêtre Library Editor 
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La section Library Completion Status nous indique alors le nombre de composants qui présentent des données 
incomplètes dans tout le projet.  

 
Figure 21. Section Library Completeness Status 

Afin de les compléter, plusieurs options sont présentées.  
 

- Remplissage manuel : 
D’une part, vous pouvez le compléter manuellement en double cliquant sur la ligne correspondant au groupe de 
composant que vous voulez rajouter des informations. Une nouvelle fenêtre intitulée « Component Table » 
s’ouvre alors. 

 
Figure 22. Double clic sur la ligne correspondant au composant du groupe Résistance afin de compléter les 

données manquantes 
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Figure 23. Fenêtre « Component Table » ouverte après le double clic sur la ligne associé au groupe Resistance 

Dans cette fenêtre Component Table, vous pouvez directement compléter les informations manquantes dans les 
cases associées. Lors de la sélection d’une case, la description du paramètre est affichée en bas de la fenêtre.  

 
Figure 24. Description du paramètre correspondant à la case sélectionner (ici, Voltage Rated [V]) 

Pour vous aider dans la recherche des données, la section Digi-Key permet de rechercher les informations 
associées au composant sélectionné, dans les bases de données du distributeur Digi-Key, à l’aide du Part 
Number du composant. Vous pouvez également vous aider de l’option « Web Search AI Driven » pour mener des 
recherches optimisées sur internet. Enfin, si vous avez la datasheet du composant, la section « Datasheet » vous 
aidera dans cette recherche. 
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Figure 25. Options pour aider l’utilisateur dans la recherche des données 

- Remplissage automatique : 
D’autre part, vous pouvez le compléter automatiquement à l’aide des différentes options présentes sur le 
panneau droit de la fenêtre Library Editor. 

 
Figure 26. Outils pour remplir automatiquement les données relatives aux composants 

L’option Group Library permet de remplir automatiquement les informations à l’aide des bases de données de 
BQR. 
 
L’option Description Parsing permet aussi de remplir automatiquement les données manquantes par 
identification des informations de description des paramètres/propriétés des composants dans Altium Designer. 
 
Enfin, l’option Request Library permet de contacter par mail la société BQR pour remplir les informations 
manquantes à notre place.   
 

3. Les charges réelles appliquées au composant : 
Enfin, les valeurs des charges réelles appliquées peuvent être définies de 3 moyens différents.  
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- Première méthode : 
✓ La première méthode consiste à sélectionner Derating & FMECA » Rapid Stress Assignment (In 

Batch). La fenêtre associée s’ouvre alors (Figure 27).  

 
Figure 27. Fenêtre Rapid Stress Assignment (In Batch) 

✓ Afin de définir les charges opérationnelles réelles appliquées aux composants, il faudrait 
commencer par définir les « Ground Net » en sélectionnant le bouton associé en bas de page de 
l’onglet Derating & FMECA. D’ailleurs, si cela n’a pas été fait, vous auriez un message (Figure 28) 
vous renvoyant à une fenêtre qui permet de réaliser cette tâche. 

 
Figure 28. Message renvoyant à la définition des « Ground Net » 
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Figure 29. Fenêtre Ground Nets ouverte après sélection du bouton Ground Net, présente en bas de page de 

l’onglet Derating & FMECA 

✓ Dans la fenêtre Ground Nets, il suffit alors de cocher les cases associées au GND. Pour faciliter la 
recherche, un filtre est présent en haut de page de la fenêtre, et permet de trier les NetName en 
fonction des mots clés tapés dans le champ de texte. L’appui du bouton « ok » valide la sélection des 
Ground Nets et ferme la fenêtre.  

 
Figure 30. Démarche pour définir les Ground Nets 
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✓ Ensuite, avec les informations issues de la conception et du design, remplissez les tensions réelles 
appliquées au Net Name dans la colonne en blanc nommé « Voltage [V] ». 

 
Figure 31. Remplissage des tensions réelles appliquées au Net Name 

✓ Une fois remplis, cliquez sur la case « all », située en haut de la dernière colonne Apply, puis sur Save 
Stresses, et enfin sur close. (Figure 32) 

 
Figure 32. Consigne à suivre dans la fenêtre Rapid Stress Assignment 

- Deuxième méthode : 
✓ La deuxième méthode consiste à sélectionner ligne par ligne chaque composant, puis le bouton 

Stress Assignment & Derating, comme indiqué dans la Figure 33.  
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Figure 33. Consigne de la deuxième méthode pour compléter les charges opérationnelles réelles appliquées aux 

composants 

Une nouvelle fenêtre intitulée Synthelyzer Stress Assignment and Derating Calculation s’affiche alors (Figure 
34).  

 
Figure 34. Présentation de la fenêtre Synthelyzer Stress Assignment and Derating Calculation 
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Pour affecter les charges opérationnelles réelles appliquées au composant dans cette fenêtre Synthelyzer Stress 
Assignment and Derating Calculation : 
✓ Sélectionnez la ligne associée au composant 
✓ Complétez les cases blanches dans la colonne Value de la section Operational Stresses 
✓ Cliquez sur Apply 
✓ Cliquez sur ok 
✓ Répétez les consignes précédentes pour le reste des autres composants 

 
Figure 35. Consigne pour appliquer les charges réelles opérationnelles au composant 

- La troisième méthode : 
La troisième méthode se réalise au niveau du schéma. Pour cela :  
✓ Ouvrez un schéma 
✓ A partir des informations liées à la conception et design du schéma, sélectionnez les composants 

qui ont les mêmes propriétés (tensions, …) 
✓ Réalisez un clic droit 
✓ Sélectionnez Synthelizer Derating Full (Figure 36). 
✓ La fenêtre Synthelyzer Stress Assignment and Derating Calculation s’ouvre alors 
✓ Comme précédemment, réalisez les démarches associées à l’affectation de charges réelles 

opérationnelles dans cette fenêtre  
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Figure 36. Sélection des composants depuis le schéma et clic droit » Synthelizer Derating Full pour afficher la 

fenêtre 

 

 

Remarque :   
Étant donné que les 6 composants sélectionnés sont connectés, il est possible de 
cocher l’option « Propagate to Connected Components » afin que l’outil renseigne 
automatiquement les charges appliquées aux 5 autres composants, évitant ainsi une 
saisie manuelle ligne par ligne (Figure 37). 

 
Figure 37. Démarche en utilisant l’option de propagation « Propagate to Connected Components »  
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4. Analyse du stress électrique (derating) : 
Une fois que toutes les charges réelles opérationnelles ont été renseignées pour les composants, vous pouvez 
lancer l’analyse de stress électrique. Celui-ci consiste à déterminer le pourcentage de la charge nominale, 
puis à le comparer à la charge réelle appliquée au composant.  

- Si ce pourcentage est inférieur à la charge réelle, le composant est en situation de 
sursollicitation (overstress).  

- Dans le cas contraire, il est en situation de surdimensionnement (overdesign). 
 
Les démarches à suivre pour lancer le calcul sont les suivantes :  
✓ Dans l’onglet Derating & FMECA, sélectionnez les composants que vous voulez analyser (ou sinon 

sélectionner Select All Rows pour sélectionner tous les composants) 

 
Figure 38. Etapes 1 et 2 des démarches à suivre pour lancer le calcul de Derating 

✓ Cliquez sur le bouton Stress Assignment & Derating. La fenêtre Synthelyzer Stress Assignment 
and Derating Calculation s’ouvre alors (Figure 39). 

✓ Dans la section Calculation, cliquez sur le bouton Run. Un message de synthèse s’affiche alors à 
l’écran (Figure 39). 
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Figure 39. Etape 3 des démarches à suivre pour lancer le calcul de Derating 

✓ Le résultat est affiché dans les colonnes Res1, Res2, Res3, Res4, … 
 
Pour analyser le résultat obtenu : 

- Filtre : 
Vous pouvez filtrer les composants en montrant uniquement les composants en Over-Stress, 
ou en Over-Design, ou les composants non assignés (Figure 40). 

 
Figure 40. Filtre présente dans la fenêtre Synthelyzer Stress Assignment and Derating Calculation 

- Détails du résultat de l’analyse par composant : 
En sélectionnant la ligne du composant, puis en réalisant un clic droit, vous pouvez voir le 
résultat en sélectionnant « Stress Results » (Figure 41). Celle-ci ouvre une nouvelle fenêtre 
intitulée Stress Analysis Results qui donne des détails sur l’analyse du derating et aussi une 
recommandation (Figure 42). D’autre part, Clic droit » Thermal Parameters permet d’ouvrir une 
nouvelle fenêtre permettant la saisie des paramètres thermiques (Figure 43). 



- 25 - 

EDA Expert          
TUTORIEL FiXtress   

 

 
Figure 41. Clic droit sur une ligne de composant pour avoir les détails de l'analyse 

 
Figure 42. Fenêtre Stress Analysis Results 

 
Figure 43. Fenêtre Thermal Parameters 

- Remplacement de composant : 
Afin d’appliquer les recommandations, en remplaçant les composants en over-stress ou over-design, 
double cliquez sur la ligne du composant. Cela vous renvoie directement à l’emplacement du 
composant sélectionné dans votre schéma. Enfin, une fois les ajustements terminés, n’oubliez pas de 
sauvegarder les informations en appuyant sur le bouton Save Stresses (Figure 44). Notons aussi que 
le cocher de la case Set Critical color est une option qui permet de colorer les composants critiques 
(composant en overstress et overdesign) dans le schéma.  
 

- Génération de rapport d’analyse : 
Comme son nom l’indique, le bouton Report permet de créer un rapport du derating en créant un 
fichier XML ou Excel. La démarche est indiquée dans la Figure 44. 
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Figure 44. Démarche pour générer un rapport 
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Calcul de MTBF par la méthode Parts Count du MIL-HDBK-217F 
La méthode Parts Count est une approche simplifiée de prédiction de fiabilité, définie par la norme MIL-HDBK-
217F, et principalement utilisée en phase de conception préliminaire, lorsque peu d’informations techniques sont 
encore disponibles (température, tensions, courant, …). 
 
 Dans sa version originale définie par la norme, le taux de défaillance prédit d’un ensemble de composants (𝜆𝑝) 
est calculé par la formule : 

𝝀𝒑 = 𝝀𝒃 × 𝑵 
𝜆𝑏 : étant le taux de défaillance de base, déterminé par le groupe et le type de composant selon la norme 
𝑁 : étant le nombre de composants identiques dans le système 
 

 

 

Remarque :   
Ce taux de base 𝜆𝑏 est fourni par la norme MIL-HDBK-217F pour un environnement standardisé 
(Ground, Benign) et un niveau de qualité fixé par défaut (souvent « Commercial » ou « MIL-grade »), 
sans modulation via les facteurs de correction. Cette formule ne tient donc pas en compte le profil 
environnemental réel, ni le niveau de qualité spécifique, ni les contraintes de stress appliquées au 
composant.  

 
Une version étendue et enrichie de la méthode est ici utilisée par fiXtress afin de tenir compte de la qualité et de 
l’environnement : 

𝝀𝒑 = 𝝀𝒃 × 𝑵 × 𝝅𝑸 × 𝝅𝑬 
𝜋𝑄  : étant le facteur qualité 
𝜋𝐸  : étant le facteur environnemental, selon le type de profil environnemental où le composant sera utilisé 
 
L’onglet “Parts Count Prediction MTBF” utilise ainsi cette version enrichie de la méthode Parts Count pour 
estimer le taux de défaillance individuel 𝜆𝑝 (FR) pour chaque composant, le taux de défaillance total du système 
et le MTBF (Mean Time Between Failures) global du système.  
 
Les fonctionnalités sont regroupées par différentes zones : 
 

- Zone de configuration des composants :  
Les cases blanches du tableau principal permettent de définir le groupe, type et niveau de 
qualité du composant.  
Rappelons d’une part que, le groupe et le type du composant permettent de définir le taux de 
défaillance de base (𝜆𝑏) selon la norme, et d’autre part, le niveau de qualité permet de définir le 
facteur qualité 𝜋𝑄. Enfin, le facteur N est défini par la colonne associée à la quantité de 
composants identique dans le système (colonne Qty dans le tableau principal). 

 
- Zone de commandes principales : 

En bas à gauche de l’onglet se trouve 4 boutons de commandes principales.  
Save Library permet de sauvegarder, Calculate permet de lancer le calcul des taux de 
défaillance et de MTBF, Report permet d’exporter un rapport de prédiction de fiabilité. Le bouton 
Default Settings permet d’ouvrir une fenêtre Parts Count Default Setting (Figure 45), qui 
permet de régler les configurations par défauts du type de composant pour un groupe donné, 
ainsi que sa qualité pour un type de composant donné. 
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Figure 45. Bouton Default Setting 

- Zone de réglage de l’environnement :  
Cette section permet de spécifier le profil d’environnement dans lequel le système évoluera, 
impactant directement le facteur environnement 𝜋𝐸. Plus l’environnement est sévère, plus 𝜋𝐸  
augmente, traduisant un risque de défaillance accru. 
 

- Zone de configuration de l’unité de mesure du taux de défaillance :  
L’unité du taux de défaillance peut être définit en FIT (Failures in Time, soit défaillances par 109  
h) ou en FPMH (Failures Per Million Hours = défaillances par 106  h). 

 
- Zone d’affichage des résultats de calculs :  

Cette zone affiche le taux de défaillance total (FR Total ou 𝜆𝑡𝑜𝑡𝑎𝑙) qui est égal à la somme des 
taux de défaillances individuelles de tous les composants : 𝜆𝑡𝑜𝑡𝑎𝑙 = ∑ 𝜆𝑐𝑜𝑚𝑝𝑜𝑠𝑎𝑛𝑡  

Elle affiche également le résultat du calcul de MTBF total, qui est donné par : 𝑀𝑇𝐵𝐹 =
1

𝜆𝑡𝑜𝑡𝑎𝑙
 

Le résultat du calcul de MTBF est donné en heures et en années. 
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Figure 46. Présentation de l’interface associé à l’onglet Parts Count Prediction MTBF 

Une fois les configurations terminées, vous pouvez lancer le calcul en appuyant sur le bouton Calculate (Figure 
47). La colonne FR per Unit et FR Total se remplissent alors. Le résultat final sera alors affiché dans la zone 
dédiée en bas à droite de l’onglet. Vous avez également la possibilité d’exporter les résultats dans un rapport à 
l’aide du bouton Report. 

 
Figure 47. Démarche pour lancer le calcul de FR (Failure Rates) et MTBF (Mean Time Between Failures) 
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Calcul de MTBF par la méthode Part Stress de Telcordia 332 
Afin de prédire de façon précise et individualisée le taux de défaillance de chaque composant d’un système 
électronique à partir de données de stress réelles (température, tension, environnement, …), la norme Telcordia 
SR-332 propose d’utiliser la méthode Part Stress dans l’onglet Telcordia 332.3 MTBF Prediction. 
 
Avec cette méthode Part Stress, le taux de défaillance individuelle est donné par la formule générale :  

𝝀𝒑 = 𝝀𝒃 × ∏ 𝝅𝒊

𝒊

 

𝜆𝑏 : étant le taux de défaillance de base 
𝜋𝑖  : étant les facteurs correcteurs (facteurs 𝜋) adaptés aux conditions réelles d’utilisation 
 
En appliquant cette méthode, le logiciel détaille ses calculs dans la section Count Properties pour estimer le 
taux de défaillance individuel 𝜆𝑝 (FR) pour chaque composant, le taux de défaillance total du système (Total FR) et 
le MTBF (Mean Time Between Failures) global du système. 

 
Figure 48. La section Count Properties détail la formule utilisée dans le calcul des taux de défaillances (FRate) 

Ce calcul peut être traduit par l’équation suivante : 
𝝀𝒑 = 𝝀𝒃 × 𝝅𝑬 × 𝝅𝑸 × 𝝅𝑺𝟏 × 𝝅𝑺𝟐 × 𝝅𝑻 × 𝑹𝑭 × 𝑫𝑪 

𝜆𝑏 : étant le taux de défaillance de base 
𝜋𝐸  : étant le facteur environnement 
𝜋𝑄  : étant le facteur qualité (Grade 0, I, II, III) 
𝜋𝑆1 𝑒𝑡 𝜋𝑆2 : étant les facteurs de stress électriques spécifiques au composant (tension, courant, charge, …) 
𝜋𝑇 : étant le facteur température 
𝑅𝐹 : Reliability Factor ou facteur d’ajustement de fiabilité pour l’utilisateur (souvent 1 si non spécifié) 
𝐷𝐶 : Duty Cycle ou facteur de cycle de fonctionnement 
 
Différentes fonctionnalités sont regroupées par différentes zones :  

- Zone centrale :  
La zone centrale est occupée par le tableau de données. Celle-ci comporte des colonnes en 
bleu et des colonnes en blanc. De manière générale, les cases (colonnes) en bleu sont 
remplies de données non modifiables, tandis que les cases blanches contiennent des 
paramètres configurables et modifiables. Les colonnes intitulées dT, DC (Duty Cycle), P [W], 
V[V], et I [A], sont les colonnes qui contiennent les informations associées aux stress réels 
appliquées au composant. En fonction du composant, ces colonnes sont composées de cases 
blanches ou bleues. Dans un premier temps, il faudrait remplir du mieux que possible les cases 
blanches de ces colonnes.   
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- Zone de configuration de la température et de l’environnement :  
Situé au-dessus du tableau principal de données se trouvent les paramètres thermiques et 
environnementaux.  
Veuillez indiquer dans l’entrée dédiée à la température, la valeur de la température dans 
laquelle le système évoluera. La configuration de celle-ci impactera sur la valeur du facteur 
température 𝜋𝑇.  
Ensuite, sélectionnez à travers le menu déroulant les conditions de l’environnement. L’échelle 
de sévérité de l’environnement est la suivante (du moins sévère au plus sévère) :   
Ground Benign < Ground Fixed (1,2,3) < Ground Mobile < Airborne, Inhabited, Cargo < Space, 
Flight. La configuration de celle-ci impactera sur la valeur du facteur environnement 𝜋𝐸.  

 
Figure 49. Zone de configuration de la température et de l’environnement 

 
- Zone intitulée « Library Properties » : 

Zone située en haut à droite de l’onglet. Elle comporte un tableau avec différents paramètres 
éditables (les cases en blancs) et d’autres non éditables (cases en bleu). La liste des 
paramètres dépend du composant sélectionné dans le tableau de données principales. Parmi 
les paramètres éditables, certaines valeurs doivent être saisies à la main (cas pour RF, V-RT, 
Pw-RT, …) tandis que d’autres sont configurables à l’aide du menu déroulant (cas pour Group, 
Type, Quality Level, …). 

 
Figure 50. Zone Library Properties 

Rappelons d’une part que, le groupe et le type du composant permettent de définir le taux de 
défaillance de base (𝜆𝑏) selon la norme.  
Le niveau de qualité permet de définir le facteur qualité 𝜋𝑄. Dans le menu déroulant, vous 
trouverez 4 échelles, allant du niveau 0 (Commercial Reengineering) au niveau III (High Quality 
Level). 

 
Figure 51. Echelle de niveau de qualité 
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RF (Reliability Factor) correspond au facteur d’ajustement de fiabilité pour l’utilisateur (souvent 
1 si non spécifié).  
Et enfin, Pw-RT et V-RT (selon le composant) sont reliés aux calculs de stress électrique, car ils 
correspondent aux valeurs nominales des charges applicables au composant.  

 
- Zone intitulée « Count Properties » : 

C’est une zone qui comporte un tableau d’information pour le composant sélectionné. Les deux 
premières colonnes sont dédiées à la liste des facteurs 𝜋 (et des stress), la troisième colonne 
contient les valeurs définies ou calculées pour chaque facteur 𝜋, et enfin la dernière colonne est 
dédiée aux unités (sauf pour la ligne associée au FRate ou la case contient la formule générale 
appliquée pour calculer FRate). 

 
Figure 52. Zone Count Properties 

- Zone de configuration de l’unité de mesure du taux de défaillance (FR) :  
L’unité du taux de défaillance peut être définit en FIT (Failures in Time, soit défaillances par 109  
h) ou en FPMH (Failures Per Million Hours = défaillances par 106  h). 

 
- Zone dédiée aux commandes principales : 

En bas à gauche de l’onglet, huit boutons de commande principale sont disponibles : 

 
Figure 53. Zone dédie aux commandes principales 

Stresses et Clear Stresses permettent respectivement de sauvegarder et de supprimer les 
différentes contraintes saisies.  
Import Stresses permet de charger un fichier contenant des contraintes prédéfinies.  
Default Settings ouvre la fenêtre T332.3 (Telcordia SR-332.v3) Default Setting (Figure 54), pour 
configurer les paramètres par défauts du type de composant pour un groupe donné, ainsi que la 
qualité, le facteur d’ajustement RF, V[%], I[%], P[%], par défaut pour un type de composant 
donné. 
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Figure 54. Default Settings 

Save Library et Import Library servent à enregistrer ou charger une bibliothèque de 
composants.  
Le bouton Calculate permet de lancer le calcul du taux de défaillance individuelle de chaque 
composant en remplissant d’une part la colonne FRate du tableau de données principal, puis en 
déduisant le taux de défaillance total du système (FR Total ou 𝜆𝑡𝑜𝑡𝑎𝑙), lance le calcul du MTBF 
total du système. 
Enfin, le bouton report permet de générer un rapport détaillé des résultats. 

 
- Zone d’affichage des résultats de calculs :  

Cette zone affiche le taux de défaillance total (FR Total ou 𝜆𝑡𝑜𝑡𝑎𝑙) qui est égal à la somme des 
taux de défaillances individuelles de tous les composants : 𝜆𝑡𝑜𝑡𝑎𝑙 = ∑ 𝜆𝑐𝑜𝑚𝑝𝑜𝑠𝑎𝑛𝑡  

Elle affiche également le résultat du calcul de MTBF total, qui est donné par : 𝑀𝑇𝐵𝐹 =
1

𝜆𝑡𝑜𝑡𝑎𝑙
 

Le résultat du calcul de MTBF est donné en heures et en années. 
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Figure 55. Présentation générale de l’interface de l’onglet Telcordia 332.3 MTBF Prediction 
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INTRODUCTION 
 

Installation du logiciel 
Après avoir contacté BQR, vous recevrez un fichier pour installer le logiciel fiXtress.  
 

Vérification de la licence 
L’installation du logiciel génère la création d’un fichier BQRHostId.dat.  
✓ Recherchez ce fichier BQRHostId.dat dans Ce PC » OS (C :) » Programmes » BQR » Full Suite (Figure 

56). 

 
Figure 56. Chemin d'accès pour trouver le fichier BQRHostId.dat 

✓ Envoyer le fichier par email à la société BQR. 
✓ Vous recevrez ensuite en retour du mail, un mail de BQR contenant un fichier LicenBQR.dat. 
✓ Sauvegarder le fichier LicenBQR.dat dans le dossier Full Suite (Ce PC » OS (C :) » Programmes » 

BQR » Full Suite) 
✓ Dans le dossier Bin, exécuter l’application BQRConfig.exe (Figure 57). 
✓ Dans la nouvelle fenêtre BQR Suite Config, spécifier le chemin d’accès vers la licence 

LicenBQR.dat, dans l’onglet Licence (Figure 57). 
✓ Cliquez sur License Check de la fenêtre BQR Suite Config pour vérifier les fonctionnalités que votre 

licence vous donne accès (Figure 58). 
✓ Pour fermer les fenêtres, cliquez sur Close » Apply (Figure 58). 
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Figure 57. Démarches pour installer la licence (partie 1/2) 

 
Figure 58. Démarches pour installer la licence (partie 2/2) 
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Généralités sur la démarche à suivre pour lancer le calcul de MTBF 
Afin d’aboutir à la prédiction du MTBF du système électronique à l’aide de fiXtress, les démarches à réaliser sont 
résumées dans la Figure 59 suivante. 

 
Figure 59. Démarches pour réaliser une prédiction MTBF avec fiXtress 

Comme indiqué dans le schéma précédent, la démarche complète se divise en deux grandes parties :  
- Partie 1 (bloc en vert) : Démarches dans l’extension fiXtress dans les outils ECAD (Altium, 

Cadence, …)  
- Partie 2 (Bloc en bleu) : Démarches dans le logiciel fiXtress 
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PREPARATION : EXPORTATION DU BOM DEPUIS ALTIUM DESIGNER 
 

Avant toute analyse, fiXtress a besoin de connaître les composants de votre système électronique. Il faut donc 
exporter un Bill of Materials (BOM) enrichie contenant les informations nécessaires à l’analyse de stress et à la 
prédiction MTBF.  
Dans la suite des démarches, nous prenons comme outil de conception de référence Altium Designer. 
 

 

 

Remarque :   
Si vous avez déjà une BOM correctement renseignée, vous pouvez passer 
directement à l’étape suivante. 

 

Getting Started with fiXtress 
 
✓ Installez l’extension (plug-in) fiXtress dans Altium Designer. (cf. module 1) 
✓ Vérifiez à l’aide des menus déroulants que chaque colonne de la BOM correspond bien à celles 

requises par fiXtress (Figure 60). 

 
Figure 60. Vérification et ajustement des menus déroulants 

 

Stress Assignment 
✓ Affectez les stress électriques (tension, courant, température, …) à chaque composant à l’aide de 

l’onglet Derating & FMECA (cf. module 1) 
 

BOM Export 
✓ Ouvrez l’onglet setup dans le plug-In. 
✓ Enregistrez la BOM enrichie dans un fichier de format .csv compatible avec le logiciel fiXtress en 

cliquant sur le bouton … associé à la BOM, spécifiez le chemin d’accès, nommez le fichier, puis 
cliquer sur enregistrer. 

✓  Cochez l’option « Stresses » dans la section Include in BOM, puis cliquer sur save pour générer le 
fichier .csv 

✓ Suivez la suite des indications indiquées dans la Figure 61 à Figure 64 suivante.  
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Figure 61. Démarche à suivre pour l’exportation du BOM (1/4) 

 
Figure 62. Démarche à suivre pour l’exportation du BOM (2/4) 

 
Figure 63. Démarche à suivre pour l’exportation du BOM (3/4) 

 
Figure 64. Démarche à suivre pour l’exportation du BOM (4/4) 
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DEMARCHES POUR PREDIR LE MTBF D’UN SYSTEME DANS FIXTRESS 
 

Une fois la BOM enregistrée et exportée, ouvrez le logiciel fiXtress pour poursuivre l’analyse.  
 

 
Figure 65. Ouverture de fiXtress lors de la sélection du bouton Launch fiXtress 

1. Import de la BOM 
✓ Importez le fichier BOM dans fiXtress, en suivant les indications montrées dans la Figure 66. 

Plusieurs méthodes vous sont présentées. La méthode présentée dans la Figure 66 consiste à suivre la suite de 
sélection suivante pour créer un nouveau projet : Blank » Spécifiez le chemin d’accès » Nommez le fichier .mtbf » 
ouvrir. 

 
Figure 66. Démarches à suivre pour créer un nouveau projet 

✓ Ensuite, suivez la suite de sélection indiquée dans la Figure 67 suivante pour importer le fichier BOM. 

 

 

Remarque :   
Vous pouvez vous aider du bouton « Launch fiXtress » pour ouvrir directement le 
logiciel depuis le plug-In. 
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Figure 67. Démarches à suivre pour importer le fichier BOM 

✓ Cliquez sur OK à toutes les éventuelles nouvelles fenêtres d’information ouvertes, jusqu’à 
l’obtention du message : Operation has been completed successfully (Figure 68). 

 
Figure 68. Fenêtre d’information “Operation has been completed successfully” 

 

 

Remarque :   
Notons que plusieurs options de création et d’importation sont disponibles dans 
la page d’accueil du logiciel (Figure 69). 
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Figure 69. Page d’accueil de fiXtress avec des encadrés en jaune sur les options de créations, d’importations de 

fichier et les projets récents 

✓ Vous verrez apparaître une table contenant tous les composants et leurs attributs (valeurs, stress, …) 

 
Figure 70. Table contenant tous les composants et leurs attributs une fois la BOM importer 

 



- 45 - 

EDA Expert          
TUTORIEL FiXtress   

 

2. Sélection de la méthode de prédiction et configurations des conditions de prédiction 
 
✓ Allez dans l’onglet MTBF » Conditions 

 

 
Figure 71. Démarche à suivre : Onglet MTBF » Conditions 

Une nouvelle fenêtre intitulée Condition List s’ouvre alors. Complétez les informations requises dans cette 
fenêtre.  
 
Pour cela :  
✓ Sélectionnez la méthode de prédiction à utiliser (FIDES, MIL-HDBK-217, Telcordia, …) en la 

choisissant dans le menu déroulant de la colonne Prediction Method de la ligne sélectionnée. 

 
Figure 72. Menu déroulant proposé lors de la sélection de la méthode de prédiction 

✓ Complétez les conditions relatives à l’environnement (température ambiante, environnement, …) 
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Figure 73. Menu déroulant proposé lors de la sélection de l’environnement 

✓ Complétez les autres paramètres. 

 
Figure 74. Tableau de paramétrage dans la fenêtre Condition List 

✓ Sélectionnez la ligne de paramètre à prendre en compte pour la prédiction, puis cliquez sur le bouton 
Select (Figure 75) 

 
Figure 75. Démarche à suivre pour sélectionner la configuration de prédiction à utiliser 
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3. Library Properties Definition 
Les paramètres normalisés (valeurs nominales des tensions,  …) doivent être renseignés par l’utilisateur, car ces 
données sont nécessaires dans le calcul de déclassement (derating). La bibliothèque permet de définir ou 
compléter ces informations.  
 
Pour cela : 
✓ Sélectionnez l’onglet Libraries 

 
Figure 76. Onglet Libraries 

Deux fonctionnalités sont disponibles pour vous aider dans la réalisation de cette tâche : 

 
Figure 77. Fonctionnalité Components et Parsing Rules 

- Parsing Rules : Fonction pour remplir automatiquement à partir des descriptions des 
composants. 

 
Pour cela, suivez la démarche suivante : Libraries » Parsing Rules » Ouverture de la fenêtre Parsing Rules Editor 
(for SDTA method). 

 
Figure 78. Démarches à suivre pour utiliser la fonction Parsing Rules dans le remplissage automatique des 

paramètres 

- Components : Fonction pour remplir manuellement les paramètres. 
 
Pour cela, suivez la démarche suivante : Libraries » Components » ouverture de la fenêtre Library Editor. 
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Figure 79. Démarches à suivre pour utiliser la fonction Components 

Dans la fenêtre Library Editor :  
✓ Vérifiez que vous avez sélectionné la bonne méthode de prédiction dans le panneau gauche. 

 
Figure 80. Panneau gauche de la fenêtre Library Editor 

✓ Pour remplir les paramètres, double-cliquez sur une ligne de groupe de composant du tableau 
principal pour ouvrir une nouvelle fenêtre d’édition des paramètres intitulé Components Table. 
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Figure 81. Fenêtre Components Table 

✓ Remplissez le tableau de la fenêtre Component Table. 
Pour vous aider dans cette démarche, la section Digi-Key présente des fonctionnalités qui permettent d’ouvrir une 
page web et de lancer une recherche sur le composant sélectionné, à partir de son PartNum, dans les bases de 
données de Digi-Key (Figure 82). 

 
Figure 82. Fonctionnalité PartNum Search de la section Digi-Key 
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Remarque :   
Vous avez également la possibilité de demander directement à la société BQR de remplir la 
bibliothèque à votre place, en cliquant sur le bouton Request Library dans la fenêtre Library 
Editor. Cette option génère automatiquement un e-mail contenant les informations 
manquantes. Ce service est payant. 

 
Figure 83. Fonctionnalité Request Library dans la fenêtre Library Editor 

4. Component Derating 
Lançons l’analyse de déclassement (derating) ou de stress électrique. Pour cela : 
✓ Sélectionnez l’onglet SDTA » Derating Guidelines. Une nouvelle fenêtre Table Editor s’ouvre alors. 
✓ Dans la fenêtre Table Editor, sélectionnez SDTA » Derating Curves dans le panneau de gauche. Puis 

dans le panneau de droite, choisissez le groupe de composants pour lequel vous souhaitez 
paramétrer la courbe de déclassement.  

✓ Une nouvelle fenêtre Derating Curves s’ouvre. Vous pouvez y configurer les courbes de 
déclassement pour chaque type de composant appartenant au groupe sélectionné. 

 
 

 

Remarque :   
Les courbes de déclassement (Derating Curves) servent à définir les limites de 
fonctionnement des composants en fonction de la température. Elles permettent 
d’appliquer un pourcentage réduit par rapport à leur valeur nominale lorsque la 
température augmente, afin d’assurer une meilleure fiabilité du système.  
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Figure 84. Démarche pour configurer les courbes de déclassement 

✓ Ensuite, si cela n’a pas encore été réalisé dans le plug-In, compléter les stress électriques réels 
appliqués au composant dans les colonnes V-Stress, P-Stress et I-Stress du tableau principal. 

✓ Comme les valeurs nominales ont déjà été renseignées dans la section précédente (Library 
Properties definition), vous pouvez lancer l’analyse de stress. 

 
✓ Afin d’analyser les stress, sélectionnez SDTA » Calculate.  
✓ Une fenêtre Stress and Thermal Analysis s’ouvre alors. Vérifiez que la section Conditions 

correspond bien à ce que vous avez renseigné précédemment, puis cliquez sur Run. 

 
Figure 85. Démarche pour lancer l’analyse de stress 

Le tableau principal s’actualise alors pour afficher le résultat dans les colonnes en orange. 
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Figure 86. Résultat de l’analyse de stress. Les colonnes en orange sont encadrées en jaune dans la figure. 

Vous pouvez filtrer le résultat en montrant uniquement les composants critiques. Pour cela, sélectionnez SDTA » 
Changer le menu déroulant SDTA Full Tree en SDTA Critical Component.  
De la même manière, le filtre SDTA Missing Stress permet d’afficher uniquement les composants qui manquent 
des informations relatives au stress.  

 
Figure 87. Filtrage SDTA Critical Component du résultat 

Pour avoir les détails des résultats de l’analyse pour chaque composant : 
✓ Sélectionnez le composant 
✓ Réalisez une clique droite et cliquez sur Stress Result 

 
Figure 88. Démarches pour afficher les détails de l’analyse de stress pour chaque composant 
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✓ Une fenêtre Stress Analysis Results comportant les détails de l’analyse ainsi que les 
recommandations s’ouvrent alors. 

 
Figure 89. Fenêtre Stress Analysis Results 

5. Back Annotation (dans l’ECAD via le plug-in) 
Les résultats précédents peuvent être exportés dans l’onglet fiXtress Stress & FR Result du plug-in ECAD.  
 
Pour exporter le résultat (Figure 91) :  
✓ Dans l’onglet External Data, sélectionnez Export. 
✓ Dans la nouvelle fenêtre Export from Block, sélectionnez le bon VIP Type adapté au logiciel ECAD. 
✓ Sélectionnez « … » afin d’ouvrir une fenêtre Browse. 
✓ Dans la nouvelle fenêtre Browse, spécifiez le chemin d’accès de l’enregistrement du fichier, 

nommez le fichier, puis cliquez sur le bouton Enregistrer. 
✓ Cliquez sur le bouton GO pour lancer la génération du fichier. 

 
Figure 90. Démarches pour exporter le résultat du derating dans le plug-in 

Pour importer le résultat dans Altium (Figure 92 et 93) :  
✓ Dans l’onglet Setup, importez le fichier précédent en cliquant sur le bouton « … » associés à FiXtress 

Results. 
✓ Importer le fichier précédemment enregistré, en le sélectionnant dans la fenêtre Browse puis en 

cliquant sur le bouton ouvrir. 
✓ Actualisez les données en cliquant sur le bouton Refresh. 
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Figure 91. Démarches pour importer le résultat dans le plug-In dans Altium (1/2) 

✓ Dans l’onglet fiXtress Stress & FR Results, cliquez sur le bouton Load. 

 
Figure 92. Démarches pour importer le résultat dans le plug-In dans Altium (2/2) 

 

 

Remarque :   
Plusieurs options (Show Critical Components Only ou Show Stress Values on Scheme) 
en bas de l’écran sont disponible pour filtrer et afficher le résultat. (Figure 94) 
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Figure 93. Options 

En double-cliquant une ligne de composant dans le plug-in, on accède aux détails dans le schéma. 
Cela permet de modifier le design (changement de composants) selon les recommandations. 
 

6. MTBF Prediction 
✓ Allez dans l’onglet MTBF » MTBF Prediction » fenêtre MTBF Calculation. 
✓ Lancez le calcul MTBF avec les bonnes conditions, en sélectionnant le bouton Run, après avoir 

vérifié la section Conditions. 

 
Figure 94. Démarches pour lancer le calcul de MTBF sur fiXtress 

✓ Le logiciel affichera alors : 
 

- La valeur du MTBF tout en haut du tableau. 
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Figure 95. Résultat du calcul de Taux de défaillance (Failure Rates, FR) et de MTBF dans les encadrés en jaune 

- Une vue triée des composants selon leur Failure Rate (FR), afin d’avoir un visuel sur les 
composants les plus critiques. Pour cela, il suffit d’appuyer 1 fois sur l’entête de la colonne FR 
(1) (Figure 97). 

 
Figure 96. Appuie de la case FR(1) pour trier les « Failures Rates » par ordre croissant ou décroissant (en fonction 

de l’orientation du petit triangle) 

- Un résultat graphique en suivant MTBF » Conditions » Graph. Les courbes peuvent être 
configurées pour montrer l’évolution de FR ou du MTBF en fonction des conditions (température, 
environnement, …), et des méthodes de prédiction (FIDES, Telcordia, MIL-HDBK-217, …).  

 
Figure 97. Démarches pour afficher graphiquement le résultat. 
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Pour basculer la représentation graphique entre les deux variables (FR et MTBF), cliquez sur le bouton FR (encadré 
jaune dans la Figure 99) ou MTBF (encadré jaune dans la Figure 100) de la fenêtre Conditions Graph. 

 
Figure 98. Représentation graphique de l’évolution du MTBF en fonction de la température 

 
Figure 99. Représentation graphique de l’évolution de FR en fonction de la température 
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Remarque :   
Le logiciel permet de réaliser la prédiction de MTBF du système pour plusieurs méthodes et 
conditions en même temps (encadré en vert dans la Figure 101, 8 prédictions différentes 
ont été lancées en même temps). Vous avez la possibilité de rajouter ou supprimer d’autres 
conditions ou méthodes de prédictions à l’aide des boutons Add et Delete (encadré en 
rouge dans la Figure 101). 
Le résultat du calcul de MTBF affiché dans l’entête du tableau principal correspond au 
résultat de calcul pour la condition sélectionnée au préalable (encadré en jaune de la 
Figure 101). 

 
Figure 100. Fenêtre Condition List 

 
7. Rapport 

Une fois l’analyse terminée, vous pouvez générer un rapport selon vos besoins : 
 

- MTBF Component and Block Report :  
Ce rapport présente la liste des composants avec les stress définis (température, tension, etc.) ainsi que les taux 
de défaillance calculés pour chacun d’eux. 
 
✓ Pour cela, sélectionnez l’onglet Reports » Standard Reports.  
✓ Une fenêtre Report Level Choice s’ouvre alors, cliquez sur le bouton Make Report from Root (Figure 

102). 

 
Figure 101. Démarches à suivre pour générer un rapport par composant (partie 1/2) 
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✓ Une fenêtre Report Generator s’affiche alors à l’écran.  

 
Figure 102. Fenêtre Report Generator 

✓ Après avoir vérifié les informations (Current condition, Format, Options, …) et sélectionné MC – 
MTBF Comp’s & Blocks (Sub-Tree) dans le menu déroulant de la section Type, cliquez sur le bouton 
Run. 

 
Figure 103. Démarches pour générer le rapport par composant (partie 2/2). 

- MTBF Pareto Report :  
Ce rapport offre une vue d'ensemble de la contribution de chaque composant au taux de défaillance global du 
système. 
 
✓ La démarche est identique à celle de la génération de rapport par composant, à l’exception du choix 

du Type dans la fenêtre Report Generator.  

 
Figure 104. Démarches à suivre pour générer un rapport MTBF Pareto Report (1ère partie) 
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✓ A savoir : Reports » Standard Reports » Make Report from Root » Type: MP – MTBF Pareto ( Sub Tree) 
» Run (après vérification des informations). 

  
Figure 105. Sélection du Type MP – MTBF Pareto (Sub-Tree) dans la fenêtre Report Generator 

- MTBF Detailed Report :  
Ce rapport fournit une vue détaillée des formules et des paramètres utilisés pour chaque groupe et type de 
composant, dans le calcul du MTBF. 
 
✓ La démarche est identique à celle de la génération de rapport par composant, à l’exception du choix 

du Type dans la fenêtre Report Generator.  

 
Figure 106. Démarches à suivre pour générer un rapport MTBF Detailed Report (1ère partie) 

✓ A savoir : Reports » Standard Reports » Make Report from Root » Type: MD – MTBF Pi Detailed ( Sub 
Tree) » Run (après vérification des informations). 
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Figure 107. Sélection du Type MD – MTBF Pi Detailed (Sub-Tree) dans la fenêtre Report Generator 
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CONCLUSION 
 

C’est la fin de ce tutoriel qui se voulait être une introduction à l’utilisation du logiciel FiXtress de l’éditeur BQR. Si 
vous rencontrez des difficultés ou que vous souhaitez davantage de précisions, contactez-nous sur 
support@eda-expert.com, ou rendez-vous sur le site de https://www.bqr.com/fr/. 
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